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1.	General Information





1.1.	Overview


�xe "Overview"��xe "Overview: General"��xe "Description"�


The NotePager Net Client is the Windows based graphical client for the NotePager Net paging application.  It allows workstations on a network to send messages to the NotePager Net server, which in turn delivers the messages (via a modem or a direct cable connection) to your paging carrier(s) for delivery.  Your paging carrier will then send the message to the appropriate pager, phone, or wireless messaging device.  





The NotePager Net server application must be installed and configured before the NotePager Net Client can be used.  Please refer to the NotePager Net Server's help file for more information on the installation, configuration, and operation of the NotePager Net Server.





 


 


 





1.2.	Features & Capabilities


�xe "Features"��xe "Capabilities"�


Local and network recipient lists - on each workstation you can choose recipients from the network recipient list, or from a smaller personal recipient list which can be defined for each workstation.  Administrators can lock users into only using their local recipient list.





Scheduled messages - messages can be scheduled to be sent at a future date/time





Repeating messages - messages can be scheduled to repeat at predefined interval, for a settable period of time





Group paging - messages can be sent to a predefined group of recipients





Multiple recipients - allows a single message to be sent to more than one recipient and/or  group 





Pre-programmed messages - on each workstation, up to five pre-programmed messages can be defined





Real-time message status log - each workstation can track the progress of each message from start to finish





Real-time message status counters - displays current number of messages pending, sent, or failed from each workstation





Message character counter - displays the length of the current message





Message history log - displays a history of all messages sent from each workstation





Intelligent message queuing - messages for the same carrier are grouped together and sent during a single communications session





Point and click operation - an intuitive user interface makes the NotePager Net Client very easy to use 





Spell check - a spell check option is available on systems running MS Word 





Recipient cueing - Recipients may be selected by typing the first few letters of their name





Message splitting - Long messages are intelligently split into multiple smaller messages





Settable character limits - The maximum number of characters to be sent in a message is settable by carrier and individual recipient





On-call groups - A schedule can be setup for the recipients in a group, allowing NotePager Net to send messages to only the recipients scheduled to receive messages a that point in time.





TAP/IXO/PET compliant - supports any messaging device that follows one of these standards.  This includes cellular/pcs/digital phones, PIMS, alphanumeric and numeric pagers, PC/PCMCIA cards, billboards, etc.





Touch-Tone message delivery - NotePager Net can send messages to numeric pagers by using touch tones





Message logging - NotePager Net's general log keeps a history of all messages sent.  Each dialer can also keep a detailed log of the communication sessions with the paging carriers.





Modular / Scaleable - NotePager Net's modular architecture allows the application to be run across several computers for high throughput applications.





Reliapage - provides a way for recipients to be aware that a message has been missed.





Requeue messages - missed messages can be requeued for re-transmission to the paging carrier





High throughput & volume - NotePager Net's intelligent queuing of messages and multiple dialers (up to 16) allows for a large volume of messages to be delivered per hour.








 


 


 





1.3.	Shareware Information


�xe "Shareware"��xe "Registration"��xe "License"�


NotePager Net defaults into a 'shareware mode' until it is registered (purchased). Registration information can be entered into NotePager Net's Admin program by choosing the 'Registration' object.  The shareware version of NotePager Net only allows for two active recipients at any given time, and the server will stop itself every 3-5 days. NotePager Net's Admin program can be used to restart the paging engine after this time period.





Shareware is based on the try it before you buy it concept. This software is not free. You may try it. If you like the software and would like a complete registered version you must contact sales@notepager.net. The registration fee allows us to continue to develop quality products, notify you of updates, and provide technical support. NotePage, Inc. accepts credit cards (Visa, MasterCard, Discover & American Express), Purchase Orders, checks drawn on US banks, and wire transfers. If you have any questions or concerns regarding registration please contact sales@notepager.net. If you use any of NotePage, Inc.'s software and do not register after the trial period it is considered software piracy and is illegal.





 


 


 





1.4.	Purchasing


�xe "Purchase"��xe "Buy"�


NotePager Net can be ordered directly from NotePage, Inc:





The most current NotePager Net pricing can be found on our website:





www.notepager.net/pricing.htm


www.notepager.com/pricing.htm


www.notepage.net/pricing.htm





NotePage, Inc.


291 Rockland Street


Suite 13


Hanover, MA 02339





Phone (781) 829-0500


Fax (781) 582-1869





Accepted Payment forms are:


	Pre-payment


	COD Company Check (continental US only)


	MasterCard


	Visa


	Discover


	Purchase Orders


	(see on-line ordering below for American Express)





All payments are in US Dollars








NotePager Net can be ordered on-line at:





www.notepager.net/purchase.htm


www.notepager.com/purchase.htm


www.notepage.net/purchase.htm





Accepted Payment forms are:


	MasterCard


	Visa


	Discover


	American Express


	Purchase Orders





NotePager Net can be purchased through a NotePage authorized reseller, who can also be contracted for the installation of our products.  Please contact us for a reseller in your area.








 


 


 





1.5.	Contact Information


�xe "Contact"��xe "Company"��xe "Phone Number"��xe "Fax Number"��xe "Email Address"��xe "Mailing Address"�


NotePage, Inc.


291 Rockland Street


Suite 13


Hanover, MA  02339


USA





Mailing Address


PO Box 296


Hanover, MA  02339





web 	www.notepager.net





email	sales@notepager.net





phone	(781) 829-0500





fax	(781) 582-1869





 


 


 





1.6.	Version Information


�xe "Version"�


NotePager Net Client Help File





For NotePager Net version 3.7





Copyright 1997-2001 NotePage, Inc.








 


 


 





1.7.	End User License Agreement


�xe "License Agreement"��xe "End User License Agreement"��xe "EULA"�


END-USER LICENSE AGREEMENT FOR NotePager Net


NotePager NetIMPORTANT PLEASE READ THE TERMS AND CONDITIONS OF THIS LICENSE AGREEMENT CAREFULLY BEFORE CONTINUING WITH THIS PROGRAM INSTALL:  


NotePage, Inc.'s End-User License Agreement ("EULA") is a legal agreement between you (either an individual or a single entity) and NotePage, Inc. for the NotePage software product(s) identified above which may include associated software components, media, printed materials, and "online" or electronic documentation ("SOFTWARE PRODUCT"). By installing, copying, or otherwise using the SOFTWARE PRODUCT, you agree to be bound by the terms of this EULA. This license agreement represents the entire agreement concerning the program between you and NotePage, Inc., (referred to as "licensor"), and it supersedes any prior proposal, representation, or understanding between the parties.  If you do not agree to the terms of this EULA, do not install or use the SOFTWARE PRODUCT. 





The SOFTWARE PRODUCT is protected by copyright laws and international copyright treaties, as well as other intellectual property laws and treaties. The SOFTWARE PRODUCT is licensed, not sold. 





1. GRANT OF LICENSE.  The SOFTWARE PRODUCT is licensed as follows: 


(a) Installation and Use. NotePage, Inc. grants you the right to install and use copies of the SOFTWARE PRODUCT on your computer running a validly licensed copy of the operating system for which the SOFTWARE PRODUCT was designed [e.g., Windows 95®, Windows NT®, Windows 98®, Windows 2000 ®]. 


(b) Backup Copies. You may also make copies of the SOFTWARE PRODUCT as may be necessary for backup and archival purposes. 





2. DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS. 


(a) Maintenance of Copyright Notices.You must not remove or alter any copyright notices on any and all copies of the SOFTWARE PRODUCT. 


(b) Distribution. You may not distribute registered copies of the SOFTWARE PRODUCT to third parties.  Evaluation versions available for download from NotePage, Inc.'s websites may be freely distributed.


(c) Prohibition on Reverse Engineering, Decompilation, and Disassembly. You may not reverse engineer, decompile, or disassemble the SOFTWARE PRODUCT, except and only to the extent that such activity is expressly permitted by applicable law notwithstanding this limitation. 


(d)  Rental. You may not rent, lease, or lend the SOFTWARE PRODUCT. 


(e) Support Services. NotePage, Inc. may provide you with support services related to the SOFTWARE PRODUCT ("Support Services").  Any supplemental software code provided to you as part of the Support Services shall be considered part of the SOFTWARE PRODUCT and subject to the terms and conditions of this EULA.  


(f) Compliance with Applicable Laws. You must comply with all applicable laws regarding use of the SOFTWARE PRODUCT. 








3. TERMINATION


Without prejudice to any other rights, NotePage may terminate this EULA if you fail to comply with the terms and conditions of this EULA. In such event, you must destroy all copies of the SOFTWARE PRODUCT in your possession. 





4. COPYRIGHT


All title, including but not limited to copyrights, in and to the SOFTWARE PRODUCT and any copies thereof are owned by NotePage, Inc. or its suppliers. All title and intellectual property rights in and to the content which may be accessed through use of the SOFTWARE PRODUCT is the property of the respective content owner and may be protected by applicable copyright or other intellectual property laws and treaties.  This EULA grants you no rights to use such content.  All rights not expressly granted are reserved by NotePage. 





5. NO WARRANTIES


NotePage, Inc. expressly disclaims any warranty for the SOFTWARE  PRODUCT. The SOFTWARE PRODUCT is provided "As Is" without any express or implied warranty of any kind, including but not limited to any warranties of merchantability, noninfringement, or fitness of a particular purpose. NotePage does not warrant or assume responsibility for the accuracy or completeness of any information, text, graphics, links or other items contained within the SOFTWARE PRODUCT.  NotePage makes no warranties respecting any harm that may be caused by the transmission of a computer virus, worm, time bomb, logic bomb, or other such computer program. NotePage further expressly disclaims any warranty or representation to Authorized Users or to any third party.


 


6. LIMITATION OF LIABILITY


In no event shall NotePage, Inc. be liable for any damages (including, without limitation, lost profits, business interruption, or lost information) rising out of 'Authorized Users' use of or inability to use the SOFTWARE PRODUCT, even if NotePage, Inc. has been advised of the possibility of such damages.  In no event will NotePage be liable for loss of data or for indirect, special, incidental, consequential (including lost profit), or other damages based in contract, tort or otherwise. NotePage, Inc. shall have no liability with respect to the content of the SOFTWARE PRODUCT or any part thereof, including but not limited to errors or omissions contained therein, libel, infringements of rights of publicity, privacy, trademark rights, business interruption, personal injury, loss of privacy, moral rights or the disclosure of confidential information.
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2.	Installation





2.1.	System Requirements


�xe "System Requirements"��xe "Hardware Requirements"��xe "Minimum Requirements"�


Minimum requirements to run the NotePager Net Client:





Operating System:  Windows 95, 98, ME, NT (server or workstation), or 2000 (server or professional)





Processor:  Pentium 





Memory:  8 Meg of free memory (typically 32 Meg for Windows 95/98/ME, 64 Meg for Windows NT Workstation, or 128 Meg for Windows NT Server or Windows 2000, on a bare system)





Storage:  10 Meg of free disk space 





Communications:  Network access to the NotePager Net Server's database





 


 


 





2.2.	Installation Instructions





2.2.1.	NotePager Net Server





2.2.1.a.	Overview


�xe "Overview"��xe "Overview: NotePager Net Server Installation"�


The NotePager Net Server application must be installed and operational before the NotePager Net Client program can be used.  Please refer to the NotePager Net Server documentation for detailed instructions on the installation of the NotePager Net Server.


 


 


 





2.2.2.	NotePager Net Client





2.2.2.a.	Pre-Installation


�xe "Installation"��xe "Installation: Pre-Installation"��xe "Pre-Installation"�


here are a few things you should verify before installing the NotePager Net Client:





1. The NotePager Net Server must be installed and operational before the NotePager Net Client is installed.





2. The workstation must have network access to the paging database (pagegate.mdb).  The 


workstation must have read, write, and change permissions to this file.





3. If you plan to use the spell-checking feature, Microsoft Word 97 or 2000 must be installed on the workstation.





4. If application or database passwords have been defined  in the NPN Admin program, they will be needed to access the Client application and the NotePager Net database.








 


 


 





2.2.2.b.	CD-Rom Installation


�xe "Installation"��xe "Installation: CD-Rom"��xe "CD-Rom Installation"�


1.  Insert the NotePager Net CD-Rom into your computer.





2.  NotePager Net's setup routine will (on most computers) automatically start.  If the setup program starts, go to step 3 below.  If not, click on the Windows start button, and then choose 'Run' from the menu.  Type in 'd:\setup' without the quotes (in this example the CD-Rom drive letter is 'd'. If your CD-Rom drive letter is different, use it instead).  Next hit the 'OK' button.





3.  The setup program will present you with options for which part of NotePager Net you want to install.  To install the NotePager Net Client you should choose the second option.





4.  The following screen will display NotePager Net's End User License Agreement.  Please read it carefully and proceed with the installation of NotePager Net ONLY if you agree with ALL the terms of this agreement.





5.  On the next screen you can specify a location where you want the NotePager Net Client installed.  The default install location is C:\Program Files\NotePager Net Client\. You can change the installation path by hitting the 'Browse' button.  To accept the install location, hit 'OK'.





6.  You will now be prompted for the name of the group that the NotePager Net Client icons should be added to in the Windows Start Menu.  The default group is 'NotePager Net Client'.





7.  The setup program is now ready to install the NotePager Net Client.  Click on the 'Next' button to start the installation process. 





8.  The setup program will now copy the NotePager Net Client program and support files to your computer.  If you encounter any problems during this part of the installation, please refer to the 'Installation Troubleshooting' section of the manual.





9.  The next screen will tell you that the NotePager Net Client has been successfully installed.  Hit the 'Finish' button to exit NotePager Net's setup program.





10.  In some cases, your computer will ask to be restarted after the installation of the NotePager Net Client.  If you are prompted to do so, you must restart your computer before running the NotePager Net Client.





 


 


 





2.2.2.c.	Single executable (.exe) installation


�xe "Installation"��xe "Installation: Executable (.exe)"��xe "Executable (.exe) Installation"�


1.  Run the executable file that you downloaded (npnv3.exe).





2.  The setup program will present you with options for which part of NotePager Net you want to install.  To install the NotePager Net Client you should choose the second option.





3.  The following screen will display NotePager Net's End User License Agreement.  Please read it carefully and proceed with the installation of NotePager Net ONLY if you agree with ALL the terms of this agreement.





4.  On the next screen you can specify a location where you want the NotePager Net Client installed.  The default install location is C:\Program Files\NotePager Net Client\. You can change the installation path by hitting the 'Browse' button.  To accept the install location, hit 'OK'.





5.  You will now be prompted for the name of the group that the NotePager Net Client icons should be added to in the Windows Start Menu.  The default group is 'NotePager Net Client'.





6.  The setup program is now ready to install the NotePager Net Client.  Click on the 'Next' button to start the installation process. 





7.  The setup program will now copy the NotePager Net Client program and support files to your computer.  If you encounter any problems during this part of the installation, please refer to the 'Installation Troubleshooting' section of the manual.





8.  The next screen will tell you that the NotePager Net Client has been successfully installed.  Hit the 'Finish' button to exit NotePager Net's setup program.





9.  In some cases, your computer will ask to be restarted after the installation of the NotePager Net Client.  If you are prompted to do so, you must restart your computer before running the NotePager Net Client.








 


 


 





2.2.2.d.	Single archive (.zip) installation


�xe "Installation"��xe "Installation: Archive (.zip)"��xe "Archive (.zip) Installation"�


1.  To extract the NotePager Net installation file from the archive (.zip) file, you will need a program such as WinZip or PKZip.  Extract the contents of the .zip file that you have downloaded (npnv3.zip) into a temporary directory by using one of these utilities.





2.  Run the file named npnv3.exe from the location where you extracted NotePager Net's installation file.





3.  The setup program will present you with options for which part of NotePager Net you want to install.  To install the NotePager Net Client you should choose the second option.





4.  The following screen will display NotePager Net's End User License Agreement.  Please read it carefully and proceed with the installation of NotePager Net ONLY if you agree with ALL the terms of this agreement.





5.  On the next screen you can specify a location where you want the NotePager Net Client installed.  The default install location is C:\Program Files\NotePager Net Client\. You can change the installation path by hitting the 'Browse' button.  To accept the install location, hit 'OK'.





6.  You will now be prompted for the name of the group that the NotePager Net Client icons should be added to in the Windows Start Menu.  The default group is 'NotePager Net Client'.





7.  The setup program is now ready to install the NotePager Net Client.  Click on the 'Next' button to start the installation process. 





8.  The setup program will now copy the NotePager Net Client program and support files to your computer.  If you encounter any problems during this part of the installation, please refer to the 'Installation Troubleshooting' section of the manual.





9.  The next screen will tell you that the NotePager Net Client has been successfully installed.  Hit the 'Finish' button to exit NotePager Net's setup program.





10.  In some cases, your computer will ask to be restarted after the installation of the NotePager Net Client.  If you are prompted to do so, you must restart your computer before running the NotePager Net Client.





 


 


 





2.2.2.e.	Promptless automatic installation


�xe "Installation"��xe "Installation: Promptless"��xe "Installation: Quiet"��xe "Promptless Installation"��xe "Quite Installation"��xe "Automatic Installation"�


The NotePager Net Client can be installed unattended.  This helps network administrators to automate the installation of the this program.





1.  Start the NotePager Net setup program as usual (see above).





2.  When the first installation screen is shown, stop there and copy the 'NPNSetup' folder that has now been created under your system's temporary directory, (usually c:\windows\temp or c:\temp) to another location.





3.  Exit out of the installation program.





4.  Use the following commandline syntax to run a promptless install.





Note: promptless installations installs the NotePager Net applications to their default locations only.





<path>npncsetup.exe /S





The <path> option should be replace with the path to where you copied the 'NPNSetup' folder in step #2 above.





Here is an example of a promptless install of the NotePager Net Client if the NPNSetup folder was copied to C:\





C:\NPNSetup\npncsetup.exe /S





Notes:


The NotePager Net client can be installed normally by running npncsetup.exe.  After the installation finishes, the install files are automatically removed from your system.  If you want the setup files to remain after installation, use a /K in the commandline.








 


 


 





2.2.2.f.	Post-Installation


�xe "Installation"��xe "Installation: Post-Installation"��xe "Post-Installation"�


1.  If you installed from CD-Rom, remove the CD and keep it in a safe place.  You will need it again if you ever need to reinstall NotePager Net, or want to install the NotePager Net Admin program, the NotePager Net Monitor program, or the NotePager Net Client program on an additional workstation.





2.  If you installed the NotePager Net Client from a single downloaded file (npnv3.exe or npnv3.zip), be sure to make a copy of the file and store it in a safe place. You will need it again if you ever need to reinstall NotePager Net, or want to install the NotePager Net Admin program, the NotePager Net Monitor program, or the NotePager Net Client program on an additional workstation.





 


 


 





2.2.2.g.	Installation Troubleshooting





Problem:  Any number of different problems


Solution:  Be sure that there are no other programs running when you install the NotePager Net Client.  There may be programs running even if you don't see them in your task bar.  Pressing <ctrl><alt><del> will bring up a list of running programs in Windows 95 and 98.  In Windows NT or 2000 you can choose 'Task Manager' after hitting <ctrl><alt><del> for similar information.  Stop any program that you believe is causing the conflict.  WARNING: this should only be done by an experienced user.  Randomly ending tasks can lock up your computer, lose data or worse.  Please consult with and experienced technician before killing any processes.  A clean reboot can sometimes also help.  Holding down the shift key while windows is starting will stop some programs from starting that normally load at startup.  Try re-running the NotePager Net Client setup program.
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3.	Setup





3.1.	Setup Overview


�xe "Setup"��xe "Setup: Overview"��xe "Overview"��xe "Overview: Setup"�


There are two stages to the setup of the NotePager Net Client.  The first stage is the setup of the NotePager Net Server.  The NotePager Net Server must be installed, setup, and running in order to use the NotePager Net Client.  It should be installed and setup before attempting to run the NotePager Net Client for the first time.  The second stage is the setup of the NotePager Net Client application.





The NotePager Net Client sends messages to and receives information from the NotePager Net Server via a shared database file (pagegate.mdb).  During the setup of the NotePager Net Server you are prompted for a location for this file.  The file should be placed in a location where both the NotePager Net Server and the NotePager Net Client can access the file.  In other words, the database file (pagegate.mdb) should be in a shared network folder to which both the NotePager Net Client and the NotePager Net Server have full rights.  The default location for this file is the NotePager Net Server's program directory.  To keep the file there and use the NotePager Net Client, you must share the NotePager Net program folder on your network.





During the setup of the NotePager Net Client, you are prompted for the 'Server Database'.  You must enter (or browse using the button with three dots) the full path to the pagegate.mdb file.  If the machine you installed the NotePager Net Server on was called 'pgserver', and you installed the server to a drive shared as c-drive, and the database was installed in it's default location, the full path would be:





\\pgserver\c-drive\program files\NotePager Net\





 


 


 





3.2.	First Time Setup


�xe "Setup"��xe "Setup: First Time"�


In order to properly setup the NotePager Net Client, the NotePager Net Server must already be installed, setup, and running (refer to NotePager Net's documentation for installation and operations).





The first time you start the NotePager Net Client, the setup screen will be displayed.





1. Specifying the server's data directory.


During the setup of the NotePager Net Server, a location for NotePager Net's database was specified (pagegate.mdb).  The NotePager Net Client must know the location of that database file, in order to operate.  Type the full path to the database file in the 'Server Database' field, or use the browse button (three dots) to find its location.





2. Sender's Name


By default, each message sent by the NotePager Net Client is prefixed with the name of the sender (this behavior can be turned off in the NPN Admin program if desired).  This is where you specify that name.





3. Station Number


The station number is used in the log files to indicate which workstation a message originated from.  Each workstation should be given a unique station number (unless you want multiple workstation to share the same history log).





4. Update frequency


This sets how often (in seconds) the NotePager Net Client updates its statistics and logs.  Too small a value may generate unnecessary network traffic.





5. Local Recipient List Only


This option can be use to only allow the user of this program to see recipients in their local recipient list.  The full network recipient list will not be accessible.





6. Enable Spell Check


If you have Microsoft Word 97 or newer, you can enable this option to allow for the spell checking of messages.





7. Choose to save the above setting for all users of this workstation, or for only the currently logged in user.





8. Apply your changes.





Setup of the NotePager Net Client is now complete.  You are ready to send messages!





 


 


 


�



4.	Operation





4.1.	Sending a Message


�xe "Operation"��xe "Operation: Sending a Message"��xe "Sending a Message"�


Sending a message is as easy as 1, 2, 3.





1. Choose a recipient(s) from the 'Recipient List'. Selected recipients will move to the 'Selected Recipients' list.





2. Enter a message in the 'Message Text' box.





3. Hit the 'SEND' button.





DONE !!!





 


 


 





4.2.	Shortcuts, Hints, and Things You Should Know


�xe "Operation"��xe "Operation: Shortcuts"��xe "Shortcuts"��xe "Hints"�


The 'Clear' button next to the 'Selected Recipients' list will clear all the selected recipients





The 'Clear' button next to the 'Message Text' box will clear the entire message text





Clicking on the 'Prog1' - 'Prog5' buttons will automatically type pre-programmed messages into the 'Message Text' area.





Right-clicking on the 'Prog1' - 'Prog5' buttons will allow you to set or modify the pre-programmed message for that button.





Right-clicking anywhere in the 'Message Text' area will bring up a window with all the pre-programmed messages in it.  From there you can select or edit any of the messages.





Clicking on the 'Pending', 'Sent', or 'Bad' numbers (or labels) will bring up its respective status log.





If you have spell checking enabled, double-clicking anywhere in the 'Message Text' area will start the spell check.





If the 'Recipient List' has the focus (is the current window), you can type the first few characters of a recipient's name to jump directly to that recipient.  The <ENTER> key can then be used to select that recipient.  The 'Recipient List' get the focus after a recipient is selected, or if you right-click anywhere in the 'Recipient List' window.





Clicking on the 'Recipient List' label, or on the current list indicator next to it ('(network)' or '(local)'), will toggle between the local recipient list and the network recipient list.  A local recipient list must first be setup for this to work.





The 'OPTIONS' button allows you to schedule messages to be sent in the future or to schedule repeating messages.





If the date/time displayed in the top right corner of NotePager Net Client is in red print, one of NotePager Net's modules that is necessary to send pages, isn't running.





Clicking on the blue 'NotePager Net Client' logo will bring up the 'About' information screen.





 


 


 





4.3.	Minimizing the NotePager Net Client


�xe "Operation"��xe "Operation: Minimizing"��xe "Minimizing NotePager Net"��xe "Hiding"��xe "Icon"�


The NotePager Net Client application can be minimized to remove its window from the Windows desktop, but to keep it running for instant access.  When the NotePager Net Client is minimized, it will appear as a pager in the Windows system tray (bottom right corner next to the clock).  To restore the NotePager Net Client's window, simply click on the pager icon in the Windows system tray.


 


 


 





4.4.	Quitting


�xe "Operation"��xe "Operation: Quitting"��xe "Quitting"�


You can quit the NotePager Net Client by choosing 'Exit' from the 'File' menu, clicking on the 'X' control in the NotePager Net Client's top right corner, or by double-clicking on the pager icon in the NotePager Net Client's top left corner.  Many users find it useful to keep the NotePager Net Client running at all times, and simply keep it minimized for quick access.





 


 


 


�



5.	Reference





5.1.	Ad-Hoc


�xe "Ad-Hoc"��xe "PIN number"��xe "ID number"�


Ad-Hoc messages are messages that are sent to a recipient that isn't actually setup on the NotePager Net Server.  By using Ad-Hoc, messages can be sent to a recipient by choosing the recipient's paging carrier (by choosing the carrier's ad-hoc recipient that must already be setup in NotePager Net) and providing the ID/PIN number for the recipient's pager (or other wireless messaging device).  Ad-Hoc recipients that have been setup in NotePager Net will show up at the beginning of the 'Recipient List' and will have the text '(A)' before their name.  If you choose an Ad-Hoc recipient, you will be prompted for the recipient's ID/PIN number before the entry is moved into the 'Selected Recipients List'.  Note:  the Ad-Hoc message feature is not available unless you own a 5000 pager license or greater.


 


 


 





5.2.	Bad


�xe "Bad"�


The 'Bad' status number on the main NotePager Net Client screen shows how many messages produced errors when being delivered by the NotePager Net Server.  These messages were not successfully sent to the recipient's pager.  Please see your NotePager Net administrator or the NotePager Net Server documentation for possible causes, more detailed information and troubleshooting tips.  By clicking on the 'Bad' label, you can bring up the full 'Bad Messages' log.  See 'Bad Messages' for more information about this log.





 


 


 





5.3.	Bad Messages


�xe "Bad Messages"�


The 'Bad Messages' log shows information about messages that have received errors while being delivered by the NotePager Net Server.  Information is only shown for messages sent during the current session of the NotePager Net Client.  This log displays whom the message was sent to, when it was sent to the paging server, the current message status, and the beginning of the actual message.  The 'Refresh' button will update the displayed information.  The 'Requeue' button will change the highlighted message's status from 'bad' back to 'pending' (the message will be resent by the paging server).  The 'Close' button will close the log screen.  Please see your NotePager Net administrator or the NotePager Net Server documentation for possible causes, more detailed information and troubleshooting tips.  The 'Bad Messages' log can be accessed by choosing 'Bad' form the 'View' menu, or by clicking on the 'Bad' label on the NotePager Net Client's main screen.





 


 


 





5.4.	Characters


�xe "Characters"��xe "Counter"�


NotePager Net Client has a character counter that displays on the main screen.  It updates itself as a message is typed into the 'Message Text' area.  This number in not necessarily the exact number of characters sent out in the actual message.  The sender's name may be added to the beginning of each message depending on settings for each recipient.  Also,  options such as 'Reliapage' add more information to the message before it is sent out.





 


 


 





5.5.	Clear


�xe "Clear"�


Two 'Clear' buttons appear on NotePager Net Client's main screen.  The 'Clear' button immediately to the right of the 'Selected Recipients' list clears all the selected recipients.  The 'Clear' button immediately to the right of the 'Message Text' box, clears any text in its box.





 


 


 





5.6.	Clear on Send


�xe "Clear on Send"�


If the 'Clear on send' setting in NotePager Net Client's setup screen is enabled, whenever a message is sent by the user, the 'Selected Recipients' list and the 'Message Text' box will be automatically cleared.  Otherwise, these two display boxes are left in their previous state when a message is sent.


 


 


 





5.7.	Date & Time


�xe "Date"��xe "Time"�


The date and time of the NotePager Net Server is displayed in the top right corner of NotePager Net Client's main screen.  The date and time is updated at an interval set in the setup screen (see 'Update Frequency').  This is the current time of the NotePager Net server, not your local workstation.  If the date or time is incorrect, the date or time on the paging server may be wrong.  If one of NotePager Net's modules that is necessary for the NotePager Net Client to send pages is not running, the date and time will be printed in red letters.





 


 


 





5.8.	Display Options


�xe "Display Options"��xe "Remove"��xe "Remove: Preset Buttons"��xe "Remove: Options Button"��xe "Remove: Logs"��xe "Remove: Help"��xe "Remove: Spell Checking"�


The Display Options window is accessible from the NotePager Net Client setup screen.  These settings allow you to disable some of the NotePager Net Client's features.  This is useful if a simplified user interface is desired for end users.





Remove Preset Buttons:  This option will remove the programmable message buttons on the NotePager Net Client window.





Remove Option button:  This option will remove the 'Options' button from the NotePager Net Client window.  This will remove the end user's ability to send scheduled and repeating messages.





Remove Logs:  This option will remove the end user's ability to view logs regarding message status and messages sent.





Remove Help:  This option will remove the end user's ability to view the Help file.





Remove Spell Checking:  This option will remove the ability to use MS Word's spell checker to check the spelling of messages.





 


 


 





5.9.	Enable Spell Check


�xe "Spell Check"��xe "Enable Spell Check"�


The 'Enable Spell Check' checkbox is used to enable/disable the message spell checking option.  The NotePager Net Client can use Microsoft Word's spell checking dictionary.  MS Word 97 or newer is required.  The 'Enable Spell Check' setting is located on the 'Setup' screen found under the 'Tools' menu.





 


 


 





5.10.	Groups


�xe "Groups"�


Messages can be sent to a pre-defined group of recipients (groups are defined in the NPN Admin program).  Groups will show up at the beginning of the 'Recipient List' and will have the text '(G)' before their names.  When you send a message to a group, the message will be delivered to all the members of the group.





 


 


 





5.11.	History Log


�xe "History Log"��xe "Log"�


The 'History Log' shows information about all messages sent from this workstation.  The 'Station Number' set in the 'Setup' screen is used to generate this log.  If unique station numbers are not used for each workstation, messages sent from other workstations may appear in this log.  You have options of printing the log to a printer, or copying the log to your computer's clipboard for use in another application.





 


 


 





5.12.	Local Recipient Lists


�xe "Local Recipient List"��xe "Personal Recipient List"�


In the NotePager Net Client, you can select several commonly used recipients and put them into a local (personal) recipient list.  This can save you from scrolling through a long network recipient list to select the recipients you use most.  This local recipient list is unique to each NotePager Net Client.


To add recipients to the local recipient list, choose 'Local Recipients' from the 'Tools' menu.  The left box shows all the recipients setup in the NotePager Net paging server.  The right box shows which recipients will be displayed in your local recipient list.  Simply click on recipients in the 'Network Recipient List' to move them to the 'Local Recipient List'.  Also, recipients may be removed from the 'Local Recipient List' by clicking on them.  The 'Recipient List File' field can be used to centralize local recipient lists for multiple workstations.  Please see the section 'Recipient List File' for more information.  If you have a local recipient list setup, it will be the default recipient list displayed each time you startup the NotePager Net Client.





 


 


 





5.13.	Local Recipient List Only


�xe "Local Recipient List Only"�


If the 'Local Recipient List Only' setting in the NotePager Net Client's setup screen is enabled, users of the NotePager Net Client are restricted to only being able to send messages to recipients in their 'Local Recipient List'.


 


 


 





5.14.	Passwords


�xe "Passwords"��xe "Database Password"��xe "Application Password"��xe "Admin Password"��xe "Locking"�


The NotePager Net Client can use three different types of passwords.  All three of these passwords are set in the NPN Admin program by NotePager Net's administrator.  All three passwords are optional.





Database Password:  When set, this password is required to access NotePager Net's database file.  It is usually set to restrict other applications from accessing NotePager Net's database file.  If the database password has just been set or changed, the NotePager Net Client will prompt you for the new password the next time it is run.  The NotePager Net Client will store and use this password automatically each time it is started (you will be re-prompted for the database password each time it is changed).





Application Password:  This password can be set by NotePager Net's administrator to restrict access to the NotePager Net Client application.  If the password is set, the NotePager Net Client will prompt for it each time the program is started.





Admin Password:  This password can be set by NotePager Net's administrator to password protect the NotePager Net Client's Setup screen.





 


 


 





5.15.	Message Content


�xe "Message"��xe "Message: Content"�


Messages sent by NotePager Net are sent with more information than just the message itself.  Messages will be prefixed with the reliapage index (if enabled), the block number (if it is part of a large message that has been broken into smaller pieces.  i.e. 1 of 3, 2 of 3, 3 of 3), the sender's name (optional), and then the message itself.  Each of these fields is separated with a colon (:).  Most pagers have a limited character set usually consisting of upper and lower case letters, numbers, and some symbols (periods, commas, dollar signs, exclamation points, etc.).  Non printing characters such as carriage returns, line feeds, tabs, and some symbols are not commonly supported.  By default the NotePager Net Server will strip all non-printable characters from the messages.  This behavior can optionally be turned of in the NPN Admin program.


 


 


 





5.16.	Message Text


�xe "Message"��xe "Message: Text"�


The 'Message Text' area is where the actual message to be sent is typed.  Commonly used messages can be automatically entered by hitting one of the 'Prog1' - 'Prog5' buttons (see 'Presets' for information on settings and use of these buttons).  A character counter is displayed above the 'Message Text' area.  If spell checking is enabled (see 'Spell Checking'), it can be invoked by double-clicking anywhere in the 'Message Text' area.





 


 


 





5.17.	Options


�xe "Options"��xe "Scheduled Messages"��xe "Repeating Messages"�


The 'Options' button brings you to the 'Advanced Message Options' screen.  From here, scheduled and repeating messages can be setup.  To schedule a page to be sent at a future date and time, fill in the 'Send Message When' fields.  To schedule a message to be sent repeatedly, fill in the 'Send Message When' fields for when you want the first page to be sent.  Fill in the 'Resend Messages Every' fields to set the interval at which the message is to be repeated.  Finally, fill in the 'Stop Sending Message' fields to set the date and time for the message to stop being sent.





 


 


 





5.18.	Pending


�xe "Pending"�


The 'Pending' status number on the main NotePager Net Client screen shows how many messages sent by this workstation (during the current NotePager Net Client session) are still waiting to be sent by the NotePager Net Paging Server.  By clicking on the 'Pending' label, you can bring up the full 'Pending Messages' log.  See 'Pending Messages' for more information about this log.





 


 


 





5.19.	Pending Messages


�xe "Pending Messages"�


The 'Pending Messages' log shows information about messages that are waiting to be sent by the NotePager Net Paging Server.  Information is only shown for messages sent during the current session of the NotePager Net Client.  This log displays whom the message was sent to, when it was sent to the paging server, the current message status, and the beginning of the actual message.  The 'Refresh' button will update the displayed information.  The 'Delete' button will cancel the highlighted message.  The 'Close' button will close the log screen.  The 'Pending Messages' log can be accessed by choosing 'Pending' form the 'View' menu, or by clicking on the 'Pending' label on NotePager Net Client's main screen.





 


 


 





5.20.	Pre-programmed Messages


�xe "Pre-programmed Messages"�


Up to five commonly used messages can be pre-programmed for your convenience.  These messages can be automatically inserted into the 'Message Text' area by clicking on the 'Prog1' - 'Prog5' buttons.  Individual messages can be set by right-clicking on the respective 'Prog' button.  To bring up the 'Preset Messages' screen, which displays all five pre-programmed messages at the same time, either right-click anywhere in the 'Message Text' area, or choose 'Tools' -> 'Presets' from the menu.  Once in this screen, you can edit any one or all of the pre-programmed messages.  Clicking apply will save the changes and close the window.  Clicking on the button to the left of a message will accept all the changes, and insert that message into the 'Message Text' area.





 


 


 





5.21.	Recipient List File


�xe "Recipient List"��xe "Local Userlist"��xe ""�


This option appears on the 'Assign Local Recipients' screen.  It allows an administrator to keep a list of local recipients for this NotePager Net Client in a central location.  This enables the administrator to maintain local user list files in a central location.  The file is a simple Ascii text file with a single recipient name on each line of the file.


 


 


 





5.22.	Recipients


�xe "Recipients"�


In NotePager Net, 'recipient' is synonymous with 'pager' (or other wireless messaging device).  A recipient is the person who carriers the actual pager.  When NotePager Net refers to a 'recipient' it is really referring to the recipient's pager.  This approach simplifies things for the end users.  For example if a user were to replace their pager with a new unit, the user name will stay consistent, even though the pager's information would change.





 


 


 





5.23.	Scheduled and Repeating Messages


�xe "Scheduled Messages"��xe "Repeating Messages"�


Selecting the 'Options' button on the NotePager Net Client's main screen will display a window where you can schedule messages to be sent in the future, and messages that will be sent repeatedly.  To schedule a page to be sent at a future date and time, fill in the 'Send Message When' fields.  To schedule a message to be sent repeatedly, fill in the 'Send Message When' fields for when you want the first message to be sent.  Fill in the 'Resend Messages Every' fields to set the interval at which the message is resent.  Finally, fill in the 'Stop Sending Message' fields to set the date and time for the message to stop being sent.





 


 


 





5.24.	Scheduled Msgs


�xe "Scheduled Msgs"�


The 'Scheduled Msgs' menuitem can be found under the 'View' menu.  This option allows you to make changes to a message that has been scheduled for delivery, but hasn't been sent yet.





To edit a scheduled message, highlight a message entry on the 'Scheduled Messages' screen and then hit the 'Edit' button.  A message box will appear to let you know that this message will not be delivered until you hit the 'Send' button again (even if you don't make any changes).  the data from the message you selected will be filled into the regular NotePager Net Client screen.  Make the necessary changes and then resend the message by hitting the 'Send' button.





 


 


 





5.25.	Selected Recipients


�xe "Selected Recipients"�


The 'Selected Recipients' list box is displayed on the NotePager Net Client's main screen.  It lists recipients (pagers) that the next message will be sent to.  Recipients are added to the 'Selected Recipients' list by choosing them from the 'Recipient List' box (see 'Recipient List' for more details).  You can remove a single recipient from this list by simply clicking on the name of the recipient.  Clicking the 'Clear' button to the right of the 'Selected Recipients' box, will clear all the recipients in the list.





 


 


 





5.26.	Send


�xe "Send"�


Clicking on the 'Send' button will send the message in the 'Message Text' area to all the recipients (pagers) in the 'Selected Recipients' list.  The 'Send' button will animate to confirm your mouse click on the button.  The 'Message Text' and 'Selected Recipients' boxes are not cleared after clicking 'Send' (unless the 'Clear on Send' option in the setup screen is enabled), enabling you to resend the message if needed.  To clear either of these boxes, simple click the 'Clear' button to it's right.





 


 


 





5.27.	Sender's Name


�xe "Sender's Name"�


The 'Sender's Name' is sent at the beginning of each message, so the recipient knows who the message is sent from.  A short name should be used because most pagers only display a limited number of characters on their screens.  The 'Sender's Name' setting is located on the 'Setup' screen found under the 'Tools' menu.  Sending the 'Sender's Name' can optionally be disabled from within the NPN Admin program.





 


 


 





5.28.	Sent


�xe "Sent"�


The 'Sent' status number on the main NotePager Net Client screen shows how many messages have been successfully sent by this workstation (during the current NotePager Net Client session).  By clicking on the 'Sent' label, you can bring up the full 'Sent Messages' log.  See 'Sent Messages' for more information on the log.





 


 


 





5.29.	Sent Messages


�xe "Sent Messages"�


The 'Sent Messages' log shows information about messages that have been sent by the NotePager Net paging server.  Information is only shown for messages sent during the current session of the NotePager Net Client.  This log displays whom the message was sent to, when it was sent to the paging server, the current message status, and the beginning of the actual message.  The 'Refresh' button will update the displayed information.  The 'Requeue' button will resend the highlighted message.  The 'Close' button will close the log screen.  The 'Sent Messages' log can be accessed by choosing 'Sent' form the 'View' menu, or by clicking on the 'Sent' label on the NotePager Net Client's main screen.





 


 


 





5.30.	Server Database


�xe "NotePager Net Database"��xe "NotePager Net Directory"��xe "Server Database"�


The 'Server Database' specifies the location of the NotePager Net Paging Server's main database file.  The name of the database is: pagegate.mdb , and is found by default in the PageGate Server's program directory.  This field can be set by typing the full path to the database file (not including the filename itself), or by using the browse button (three dots).  The 'Server Database' setting is found on the 'Setup' screen found under the 'Tools' menu.





 


 


 





5.31.	Setup


�xe "Setup"�


The 'Setup' screen allows you to change the programs initial setup information.





The 'Server Database' specifies the location of the NotePager Net Paging Server's main database.  The NotePager Net Paging Server must be installed, setup, and running in order for the NotePager Net Client to operate.  Type the full path (not including the file name) to the NotePager Net Server's database file.  Or, use the browse button (three dots) to find the database location.





The 'Sender's Name' field allows you to set the name of the operator of this workstation.  Each message sent by NotePager Net Client is prefixed with the name of the sender (this behavior can be optionally disabled from within the NPN Admin program).





The 'Station Number' is used by the log files to indicate which workstation a message originated from.  Each workstation should be given a unique 'Station Number' (unless you want multiple workstations to share the same history log).





The 'Update Frequency' sets how often (in seconds) the NotePager Net Client updates its statistics and logs from the paging server.  Too small a value may generate unnecessary network traffic.





The 'Clear on Send' option can be checked so that whenever a message is sent, the message textbox and list of recipients the message was sent to are automatically cleared.





If the 'Small Recipient Font' box is checked, a smaller font size will be used in the recipient pick lists.





The 'Local Recipient List Only' option can be used to only allow the user of this program to see recipients in their 'Local Recipient List'.  The full 'Network Recipient List'  will not be accessible.





The 'Enable Spell Check' checkbox allows you to enable the spell checking option in the NotePager Net Client.  In order to use this option, you must have Microsoft Word 97 or newer installed on your system.





The 'Display Options' button displays a screen that allows you to disable some of the NotePager Net Client's features.  This is useful if a simplified user interface is desired for end users.





Remove Preset Buttons:  This option will remove the programmable message buttons on the NotePager Net Client window.





Remove Option button:  This option will remove the 'Options' button from the NotePager Net Client window.  This will remove the end user's ability to send scheduled and repeating messages.





Remove Logs:  This option will remove the end user's ability to view logs regarding message status and messages sent.





Remove Help:  This option will remove the end user's ability to view the Help file.





Remove Spell Checking:  This option will remove the ability to use MS Word's spell checker to check the spelling of messages.





The above settings can be saved so that all users of this workstation will use these settings, or so that only the currently logged in user uses these settings.





The 'Setup' screen is accessed by choosing 'Setup' from the 'Tools' menu





 


 


 





5.32.	Small Recipient Font


�xe "Font"�


When this box is checked, a smaller font size will be used in the recipient pick lists.  This will help when long recipient names are used.


 


 


 





5.33.	Spell Check


�xe "Spell Check"�


If the spell checking option is enabled on the 'Setup' screen, messages can be checked for spelling errors before they are sent.  The NotePager Net Client uses Microsoft Word's spell checking utility that is included in Word 97 or newer.  MS Word must be installed in order for NotePager Net Client to be able to spell check messages.  A message can be checked by double-clicking anywhere in the 'Message Text' area, or by choosing 'Check Spelling' from the 'Tools' menu.





 


 


 





5.34.	Station Number


�xe "Station Number"�


The 'Station Number' is used by the log files to indicate which station messages were sent from.  A unique number should be set to each workstation.  The 'Station Number' setting is found on the 'Setup' screen under the 'Tools' menu.  If you want a group of users to share a common history log, set their station numbers to be the same.





 


 


 





5.35.	Update Frequency


�xe "Update Frequency"�


The 'Update Frequency' setting specifies how often (in seconds) the NotePager Net Client updates its statistics and logs from NotePager Net.  Too small a value may generate unnecessary network traffic, while too large a value will not give the user current information.  The 'Update Frequency' setting is located on the 'Setup' screen found under the 'Tools' menu.





 


 


 





5.36.	Recipient List


�xe "Recipient List"�


The 'Recipient List' listbox is displayed on the NotePager Net Client's main screen.  It lists recipients (pagers) that can be chosen to send messages to.  Recipients are listed alphabetically by the recipient's full name.  Groups are listed before single recipients.  Recipients must be added to the NotePager Net paging server application before they are available to NotePager Net Client.  There are two different recipient lists maintained by NotePager Net Client.  The current list being displayed is indicated by the word next to the 'Recipient List' label.  It will read either '(network)' or '(local)'.  The network recipient list displays all recipients setup in the NotePager Net server.  A local recipient list can be setup by choosing 'Local Recipients' from the 'Tools' menu.  You may want to add commonly used recipients into your local recipient list to save time scrolling through the entire network recipient list.  You can switch between the local recipient list and the network recipient list by clicking on the 'Recipient List' label, clicking on the '(network)' or '(local)' labels, or by choosing 'Local Recipients' or 'Network Recipients' from the 'View' menu.  Recipients are moved from the 'Recipient List' to the 'Selected Recipients' list by clicking on the recipient's name.  You can also select recipients by typing the first few letters in their name and hitting <ENTER>.  This only works if the 'Recipient List' is the active control (has the focus).  Set the focus to the 'Recipient List' by right-clicking anywhere in the recipient list box.  Once a recipient is selected, it is moved from the 'Recipient List' box to the 'Selected Recipients' box.
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6.	Troubleshooting





6.1.	Date and time is red


�xe "Troubleshooting"��xe "Troubleshooting: Date - Red"��xe "Troubleshooting: Time - Red"��xe "Date"��xe "Date: Red"��xe "Time"��xe "Time: Red"�


The date and time shown on the NotePager Net Client screen is printed in red





If one of NotePager Net's modules necessary for the operation of the NotePager Net Client is not running, the NotePager Net Client will alert you by printing the date and time in red print rather than black.  Your messages will still be accepted, but won't be sent out until the problem is resolved.





 


 


 





6.2.	Date and time is wrong


�xe "Troubleshooting"��xe "Troubleshooting: Date - Wrong"��xe "Troubleshooting: Time - Wrong"��xe "Date"��xe "Date: Wrong"��xe "Time"��xe "Time: Wrong"�


The date or time shown on the NotePager Net Client screen is wrong





The NotePager Net Client receives its date and time from the NotePager Net Paging Server.  If the date or time on the NotePager Net Server is incorrect or if the server application isn't running, your local NotePager date or time may not be correct.





 


 


 





6.3.	I can't see all the recipients


�xe "Troubleshooting"��xe "Troubleshooting: Can't see recipients"��xe ""�


I can't see all the recipients setup in NotePager Net





If you have setup a local recipient list (a subset of all the NotePager Net recipients) it will be displayed as the default list when you start NotePager Net Client.  You can switch to the full NotePager Net recipient list by clicking on the 'Recipient List' heading, or by choosing 'Network Recipients' from the 'View' menu.  If the NotePager Net Client isn't registered and is running in 'shareware mode', only the first five recipients in NotePager Net will be displayed.





 


 


 





6.4.	Installation Troubleshooting


�xe "Installation"��xe "Installation: Troubleshooting"��xe "Troubleshooting: Installation"�


Problem:  Any number of different problems


Solution:  Be sure that there are no other programs running when you install NotePager Net.  There may be programs running even if you don't see them in your task bar.  Pressing <ctrl><alt><del> will bring up a list of running programs in Windows 95 and 98.  In Windows NT you can choose 'Task Manager' after hitting <ctrl><alt><del> for similar information.  Stop any programs that you believe is causing the conflict.  WARNING: this should only be done by an experienced user.  Randomly ending tasks can lock up your computer, lose data or worse.  Please consult with and experienced technician before killing any processes.  A clean reboot can sometimes also help.  Holding down the shift key while windows is starting will stop some programs from starting that automatically load at startup.  Try re-running the NotePager Net setup program.





 


 


 





6.5.	Spell checking doesn't work


�xe "Troubleshooting"��xe "Troubleshooting: Spell Checking"�


Spell checking doesn't work.





In order to use the spell checking feature in the NotePager Net Client, you must have a Windows95 version of Microsoft Word installed on the workstation (version 7 or newer. i.e. MS Office95 or Office97)





 


 


 





6.6.	Using Local Time


�xe "Troubleshooting"��xe "Troubleshooting: Local Time"��xe "Using Local Time"�


When the NotePager Net Client starts, I get the message 'Unable to synchronize with the scheduler....'





When the NotePager Net Client starts, it attempts to synchronize its clock with the clock on the paging server.  Note: this does not affect your computer's time or date.  Synchronized application time is important for efficient message delivery.  If for any reason you NotePager Net Client is unable to synchronize its time with the server, you will receive the message 'Unable to synchronize time with the scheduler.  Using local time'.  Even if you receive this message, your client will continue to operate and queue messages.  However, there may be a problem with the paging server that could interfere with the delivery of your messages.  When time is out-of-sync, the date/time display on the NotePager Net Client screen will be displayed in red.


 


 


 





6.7.	Where is the Server Database file?


�xe "Troubleshooting"��xe "Troubleshooting: NotePager Net Database"��xe "NotePager Net Database"��xe "Database Directory"�


Where is the Server Database file?





The NotePager Net Client and the NotePager Net Server must share the same database file (pagegate.mdb) to operate.  Therefore the file should be located on your network where both machines have access to the file.  Both the NotePager Net Client and the NotePager Net Server must also have full rights to read, write, and change the file contents.  The pagegate.mdb file is created by the NotePager Net Server and by default is located in the NotePager Net program directory.  If you accept this location while installing NotePager Net, be sure to make the folder a shared network folder to all the NotePager Net Client computers.
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